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1.3.

1.4.

About this manual

Copyrights

Theinformation in this document is subject to change without notice and should not be
construed as a commitment by ABB Oy. ABB Oy assumes no responsibility for any
errors that may appear in this document.

In no event shall ABB Oy beliablefor direct, indirect, special, incidental, or consequential
damages of any nature or kind arising from the use of this document, nor shall ABB Oy
be liable for incidental or consequential damages arising from use of any software or
hardware described in this document.

This document and parts thereof must not be reproduced or copied without written per-
mission from ABB Oy, and the contents thereof must not be imparted to athird party
nor used for any unauthorized purpose.

The software or hardware described in this document is furnished under alicense and
may be used, copied, or disclosed only in accordance with the terms of such license.

© Copyright 2011 ABB. All rights reserved.

Trademarks

ABB isaregistered trademark of ABB Group. All other brand or product names men-
tioned in this document may be trademarks or registered trademarks of their respective
holders.

General

Thismanual providesthorough information on FDIR configuration on Station Automation
Builder (SAB600) and the central conceptsrelated toit. You find instructions on building
FDIR project on SAB600. Information in this configuration manual is intended for
application engineers who configure the FDIR project communication structure and use
the FDIR configuration tool to set up FDIR.

Document conventions

The following conventions are used for the presentation of material:

« Thewordsin names of screen elements (for example, thetitle in thetitle bar of a
window, the label for afield of adialog box) areinitially capitalized.

«  Capitdl lettersare used for the name of akeyboard key if it islabeled on the keyboard.
For example, pressthe ENTER key.
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« Lowercaseletters are used for the name of akeyboard key that is not labeled on the
keyboard. For example, the space bar, comma key, and so on.

¢ Press CTRL+C indicates that you must hold down the CTRL key while pressing
the C key (to copy a selected object in this case).

« PressESC E Cindicates that you press and release each key in sequence (to copy
a selected object in this case).

«  Thenames of push and toggle buttons are boldfaced. For example, click OK.

e The names of menus and menu items are boldfaced. For example, the File menu.
« Thefollowing convention is used for menu operations. MenuName > Menu-

Item > CascadedM enultem. For example: select File> New > Type.

¢ The Start menu name alwaysrefersto the Start menu on the Windows taskbar.

e System prompts/messages and user responses/input are shown in the Courier font.
For example, if you enter a value out of range, the following message is displayed:

Entered value is not valid. The value must be 0 - 30

* Youcan beasked to enter the string MIF349in afield. The string is shown asfollows
in the procedure:

MIF349
*  Variables are shown using lowercase | etters:

sequence name

Use of symbols

This publication includes warning, caution, and information icons that point out safety-
related conditions or other important information. It also includes tip icons to point out
useful information to the reader. The corresponding icons should beinterpreted asfollows.

/_\ The electrical warning icon indicatesthe presence of ahazard
which could result in electrical shock.

ﬁ The warning icon indicates the presence of a hazard which
could result in personal injury.

@ The caution icon indicates important information or warning
related to the concept discussed in the text. It may indicate
the presence of a hazard which could result in corruption of
software or damage to equipment or property.
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ﬂ The information icon alerts the reader to relevant facts and

conditions.

Thetip icon indicates advice on, for example, how to design
Q your project or how to use a certain function.

Terminology

Thefollowing isalist of terms associated with COM600 that you should be familiar
with. The list contains terms that are unique to ABB or have a usage or definition that
is different from standard industry usage.

Term Description

Device A physical device that behaves as its own communication node
in the network, for example, protection relay.

Event Change of process data or an OPC internal value. Normally, an

event consists of value, quality, and timestamp.

Intelligent Electronic Device

A physical IEC 61850 device that behaves as its own commu-
nication node in the IEC 61850 protocol.

OPC Series of standards specifications aiming at open connectivity
in industrial automation and the enterprise systems that support
industry.

Property Named data item.

Abbreviations
Thefollowing isalist of abbreviations associated with COM600 that you should be
familiar with.

Abbreviation Description

FDIR Fault detection, fault isolation and load restoration
HMI Human Machine Interface
IED Intelligent Electronic Device
SAB600 Station Automation Builder 600
SLD Single Line Diagram
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Related documents

Name of the manual

MRS number

COMG600 Logic Processor User's manual 1MRS756738

Document revisions

Document version/date

Product revision
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2. Introduction

21. Overview of FDIR

FDIR on COM 600 provides afeeder automation function for radial distribution networks.
It gathers datafrom protection and control IEDsand runsafault detection, fault isolation
and load restoration (FDIR) algorithm on Logic Processor to realize automatic fault
restoration.

When afault happensin the network, FDIR on COM 600 detects the location of the fault
and issues switch operation commands to isolate faulty sections from the network and
to restore the electricity to the healthy sections. It also sends commands to |EDs con-
trolling the switchesto return to the normal pre-fault condition when afault has been
cleared.
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FDIR configuration

Building FDIR project on SAB600

To build an FDIR project on SAB600, you need to configure a proper communication
structure, singleline diagram and use FDIR Configuration Tool to automatically generate
aLogic Processor FDIR project and cross-references.

ﬂ When FDIR is used in COM®600, the single line diagram rep-
resents only the FDIR network.

The FDIR single line diagram differs from the normal COM600 substation single line

diagram. The FDIR single line diagram currently only uses the Circuit Breaker symbol
to represent a switch, the Outfeeder symbol to represent load, and Infeeder and Busbar
symbolsto represent source. Other symbolsare not usedin the FDIR singleline diagram.

FDIR communication structure

ThelEDsin the network need to be configured in the SAB600 communi cation structure.
For more information on the configuration, refer to the related communication protocol
configuration manual. Figure 3.2-1 shows an example of atypical |ED configuration.
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Project Explorer
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Figure 3.2-1 IED configuration
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Toimplement FDIR, certain settings must be configured properly to enabl e the automation
restoration logic.

Table 3.2-1 Data objects required for FDIR

Data object

Description

Mandatory/optional

LLNO/Loc

This data object is used to determine
if the switch is in Remote or Locale
mode.

Mandatory

11
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Data object Description Mandatory/optional
LLNO/Act1SG Used to change setting group on the | Optional
IED. In the FDIR configuration tool,
LLNO/Act2SG user can set the load level for different
setting groups. During FDIR opera-
LLNO/Act3SG tion, system will check the new load
LLNO/ACt4SG TES change the setting group on the
LLNO/Act5SG
LLNO/Act6SG
CSWI/Pos Used to read switch status and oper- | Mandatory
ate the switch.
MMXU/A The current measurement through the | Mandatory
IED, which is used to calculate the
load in the network.
RREC/LO The lock out signal from the IED. This | Mandatory
signal and switch open from
CSWI\Pos will contribute a fault condi-
tion in FDIR.

FDIR single line diagram

Singlelinediagram should be built to map the actual distribution network. In FDIR three
elements are used to describe distribution network: Source, Switch and Load. In FDIR
single line diagram, Infeeder or Bus Bar should be used to represent Source, Circuit
Breaker to represent Switchers, and Outfeeder to represent Load. There should always
be an Outfeeder (Load) connection between any two switches.

All objects of FDIR should be placed below one voltage level. All devices can be placed
under one bay to create asimple network. It isrecommended to configure abay for each
substation, configure a substation network under each bay and in Voltage Level to con-
figure connections among substations.

Figure 3.3-1 showsatypical singlelinediagram with 5 Sources, 15 Loadsand 20 Switches
in the network.
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Selected Object: IVDItage Lewvel j

il o

FDIR_SLD

Figure 3.3-1 FDIR Single Line Diagram

The Measurements readings from |EDs are optional. Figure 3.3-2 shows a preview of
the FDIR single line diagram.

13
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Single Line Diagram ;lglil

|Height: 540 *fidth: BO1

FDIR_SLD_preview

Figure 3.3-2 Preview of FDIR single line diagram

3.4. FDIR Configuration Tool

3.4.1. Launching FDIR Configuration Tool

To launch FDIR Configuration Tool:

1. Inthe Substation Structure, right-click the Voltage L evel node in the Substation
Structure.

2. Select FDIR Tool, see Figure 3.4.1-1.

14
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Project Explorer
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¥ cut

Copy
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launch_FDIR_configuration_tool

Figure 3.4.1-1 Launch FDIR Configuration Tool
The FDIR Tool opens.

3.4.2. FDIR Configuration Tool functions

FDIR Configuration Tool can be used for the following functions:
« enabling device in the network and specifying capacity limit
«  specifying group setting

« generating FDIR Logic Processor configuration

«  changing cross references

3.4.3. Specifying network settings

Figure 3.4.3-1 shows the Networ k setup tab in FDIR Configuration Tool, in which you
can enable or disable adevice in the network and change the capacity limit of sources
and switches.

15
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Figure 3.4.3-1 FDIR Configuration Tool - Network Setup

On the Switch tab, you can enable or disable the switch to be included in the FDIR net-
work. You can aso change the capacity limit on the switch. FDIR also supports single
phase switch in the network. When single phase is selected, you can select the switch
for phase B and phase C. Phase B and Phase C switch should be disabled from the FDIR
network.

On the Sour ce tab, you can enabl e or disable the source to be included in the FDIR net-
work. Also you can change the capacity limit on the source.

Onthe L oad tab, you can enable or disablethe load to be included in the FDIR network.

3.44. Setting parameters for setting groups

In the Group Settings tab, you can set parameters for setting groups, the range to
activate the setting group, a data object to read the current setting group number, and a
data object to send a command to change the setting group.

16
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Voltage Level - FDIR Tool | » q P X
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Figure 3.4.4-1 Protection Setting Group

Changing cross references

In the Data Connection tab, you can view and manually change the cross reference of
FDIR variables.

The Variable column contains alist of variables used in the FDIR logic. The OPC item
containsthe mappingsfor the variablesin the OPC servers of the communication structure.
The data connection mapping isatable view of thelogic processor crossreference, which
is generated by the FDIR configuration tool. The FDIR configuration tool uses data
connection information in the substation structure to find the corresponding switch data
object for the variables. Any change on the data connection tableisreflected onthelogic
processor cross reference.

To change the cross reference:
1. Sdect therow and click Change.

2. The Select Cross Reference dialog opens with alist of available data objects to
select, see Figure 3.4.5-2.

3. Sdlect any data object on thelist, and click OK.

17
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Figure 3.4.5-1 Data Connection

FDIR_data_connection
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Figure 3.4.5-2 Slect Cross Reference

3.4.6. Generating FDIR Logic Processor configuration

Another result of FDIR Configuration Tool isthe Logic Processor cross reference. In
the communication structure, right-click L ogic Processor and select Cross Refer ences.
Cross Reference Tool opens between OPC Server data objects and L ogic Processor
variables automatically generated by FDIR configuration.

19
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Figure 3.4.6-1 Cross Reference

Options
The Options tab shows the options you can select when running the FDIR tool.

If you add your own cross references, clear the Update Cross References check box to
prevent the changes from being overwritten when you run the tool the next time. If you
add your own logictothe FDIR logic project, clear the Update L ogic Processor Project
check box to prevent the changes from being overwritten.



1MRS757278 Station Automation COM600 3.5

FDIR Configuration Manual

valtage Level - FOTR Taal | =4 b
* Mstans | Ginup Settiags Dptione | Data Copeeetion |
FOIR Cpticr
¥ Lipdate Croes Referencos

[ Update Lagie Proceszer Peojeet

options.png

Figure 3.4.7-1 Options

3.5. Downloading FDIR configuration

3.5.1. Downloading FDIR configuration

The following steps are required for downloading FDIR configuration to COM 600:
+ 3.5.2, Downloading FDIR Logic Processor Project
+ 3.5.3, Downloading FDIR SAB600 configuration

3.5.2. Downloading FDIR Logic Processor Project
FDIR Configuration Tool will generate the FDIR Logic Processor project automatically.

To download FDIR Logic Processor project:

1. Inthe communication structure, select L ogic Processor | ED.

2. Right-click the IED and select L ogic Editor to launch Logic Processor Editor, see
Figure 3.5.2-1.

21



Station Automation COM600 3.5 1MRS757278

FDIR Configuration Manual
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Figure 3.5.2-1 Launch Logic Editor

The FDIR project opensin a separate L ogic Processor Editor window.

In Logic Processor Editor, select Device to open the device dialog.

In the device dialog, select the default device. For more information, see Logic
Processor User Manual.

5. Select Online\Login to download the FDIR Logic Processor project.

dw

3.5.3. Downloading FDIR SAB600 configuration

After you have downloaded the FDIR L ogic Processor project, download FDIR SAB600
configuration to COM 600 with updated cross references. The FDIR configuration is
downloaded in the same way as other SAB600 projects.

To download the FDIR SAB600 configuration:

1. Inthe communication structure, select Gateway.

2. Right-click the Gateway abject and select M anagement.
3. Inthe Management dialog, select the Reset check-box.
4. Click the Update and reload configuration button.
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